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The Utilities / Data Conversion / Franklen / Payman Import command in Creative Solutions Accounting 
(CSA) can be used to import data conversion files from Franklen PAYMAN into the Payroll Solution (PRS) or 
Payroll Compliance Solution (PCS) modules within CSA. This conversion guide explains the necessary steps to 
convert your data, to identify the fields that will not be converted, and to document exceptions that you may 
encounter during the conversion process. The last section of this document explains the steps you should take to 
verify that the converted data is correct. 
 
Please review this document in its entirety before actually beginning the conversion process for a client. 

CONVERSION PROGRAM OVERVIEW 
The overall objective of the PAYMAN to CSA conversion utility is to provide a comprehensive conversion of your 
PAYMAN data to CSA. However, due to differences in processing calculations and data structures between PAYMAN 
and CSA, some PAYMAN data cannot be converted. Therefore, you should not expect to exactly duplicate results 
from PAYMAN using the converted data without adding or modifying the appropriate data in CSA.  

The conversion program requires Windows 95 or later in order to run. It cannot be run in a DOS-only or Windows 3 
environment. 

Note: Payroll check information is not converted from PAYMAN to CSA. It is recommended that you convert your 
client data at the beginning of a new quarter or year as some reports may not calculate correctly if you convert the 
client data in the middle of a quarter. Also, some manipulation of your data in PAYMAN may be required prior to 
conversion. 

Things you need to know before performing conversions for a specific company: 

! Entity Number in PAYMAN. 
! Client current payroll period end date. 
! The payroll pay frequency. 
! Any applicable federal and state withholding/FUI/SUI ID numbers. 

PROCESSING STEPS REQUIRED FOR EACH CLIENT PRIOR 
TO RUNNING THE CONVERSION PROGRAM 
! We recommend that you review the PAYMAN pays and deductions and their associated descriptions in the 

chart of accounts for each client prior to running the conversion. A Pay and Deduction Translation dialog 
is provided during the conversion so that you can translate the client�s PAYMAN pays and deductions to the 
allowable CSA payroll items. The dialog will present the description as entered in PAYMAN. If the 
description does not adequately identify what the item is used for, you should consider modifying the 
description to specifically identify the purpose. Also, the conversion program examines the descriptions 
when attempting to pre-select CSA payroll items for you. 
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! Verify that the Payroll Year and Period dates have been set up in PAYMAN. You cannot convert a PAYMAN 
client that has not established a Payroll Year. 

 
! If the PAYMAN client has state withholding deductions, please be sure that they are correctly set up and are 

functional within PAYMAN before proceeding with the conversion. The first two non-blank characters of the 
RPT HEAD text for a state withholding deduction must be the Post Office abbreviation for the state (in 
upper case). The appropriate state and/or local codes must have been entered for each affected employee. 

 
! The conversion process includes only paychecks that have been posted. Before you begin the conversion of 

any client, you should verify in PAYMAN that all relevant paychecks have been properly posted by running 
any Post and Print/Display option. Make sure that the posting process is completed, that you are in balance, 
and that the paychecks have posted without errors. 

 
! The conversion process can optionally utilize the Hours History and Annual Payroll Journal files as a source 

of payroll detail. If the PAYMAN client is set to use these files, you should determine if they contain valid 
data for the entire payroll year. If part of the data for the year has been purged, you should not use the option 
during conversion. 

 
! You may need to specify a Chart of Accounts mask when creating the client in CSA. Unless you choose the 

�Convert Sub-Accounts to Departments� option (see �Creating The Import Files� below), use 
DDDDCCCC.CC as the mask. 

 
! You will need to set up the CSA client with Withholding and SUI (SUTA) ID numbers for each applicable 

state before importing the conversion files. (If the CSA client has already been created, choose Client 
Properties from the File menu.) Click the Payroll tab. You can copy and paste the first State ID number 
from the conversion program into the State tax information grid if you have both open at the same time. 

 

INSTALLING THE PAYMAN CONVERSION PROGRAM 
Use the following steps to install the Franklen PAYMAN to Creative Solutions Accounting conversion program. 

Note: To complete the password entry in Step 4 in the following procedure, you will need a password that can be 
supplied to you by a Creative Solutions Product Support Representative. Please call the CSI HelpLine at 800-968-
0600, press 3 for accounting support, and then listen to the options available before pressing the number for Creative 
Solutions Accounting. Normal weekday support is from 9:00 AM to 8:00 PM Eastern Time.  

1. Insert the Creative Solutions Accounting CD into your CD-ROM drive. (If the CSA installation program 
begins automatically, click the Cancel button.) 

2. Click the Start button on the Windows Taskbar and choose Run. 
3. In the Run dialog, type d:\FCSPR\Setup.exe (where d: represents the CD-ROM drive).  
4. You will be prompted to enter an appropriate password (which can be obtained from a Creative Solutions 

Product Support Representative as noted above). 
5. A prompt will indicate when the extraction has been completed successfully. Click OK. 

 

CREATING THE PAYMAN IMPORT FILES 
Use the following steps to convert and import a PAYMAN client into CSA. You may refer to this document for all 
information regarding this conversion. Do not use PAYMAN while using the PAYMAN conversion program. 

1. Start the PAYMAN conversion program by clicking the PAYMAN to CSA Conversion icon in the Franklen 
folder on the Programs list. The first time you do this, you may be presented with a dialog box that will help 
you locate the ASN.DEV file used by PAYMAN. This location will generally be the ?:\FCS\PCK folder. 
Both PAYMAN and the conversion program use this file to locate the client data files. 
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2. If you have set up PAYMAN to use access codes, you will need to enter the appropriate access code when 
prompted. 

3. From the Client List, select the client (entity) you wish to convert by clicking the client name. You will note 
that information is displayed for the selected client at the bottom of the screen. This information will be 
needed when you add the client into CSA, as denoted below. If you have CSA open at the same time, you can 
click on each item to copy the text or date into memory. You can then paste this information into the 
appropriate field in CSA. Click the F5=Convert button (or use the F5 function key) to begin the conversion 
process. 

4. The Pay and Deductions translation screen is now displayed. Use this screen to translate PAYMAN pay and 
deductions to the appropriate CSA payroll items. Any items denoted in red have not been assigned and will 
not be imported into CSA unless you assign them to a valid CSA pay or deduction item. 

5. Pay conversion: 
• Not all PAYMAN pay items will appear on this screen. Regular, Overtime, Sick and Vacation pay will 

be automatically converted to the appropriate CSA pay items. 
• The Other Pay item is used to convert all taxable wages that do not fit in any other category. By 

default, this pay is set to convert to the CSA pay item Other Wages. 
• The Non-Taxable Pay item is used to convert all non-taxable wages that do not fit into any other 

category. By default, this pay is set to convert to the CSA pay item Non-tax Compensation. 
• If you have set up any employees in PAYMAN with miscellaneous pay items 1 and/or 2, they will 

appear in the list as Misc Pay to Account XXXX (chart of accounts description). The conversion 
program will attempt to pre-select an appropriate CSA pay item based on the PAYMAN chart of accounts 
description. You may select a different CSA pay item from the drop-down list in the PRS Pay column. 
Note: The conversion program uses the GL account to distinguish miscellaneous pay from standard pay. 
If a miscellaneous pay uses the same GL account number as a standard pay, it will be incorrectly 
combined with the standard pay, and it will not appear in the list of pay items. The pay totals for the 
standard pay may not be imported correctly in such cases. 

• Where applicable, the conversion program will automatically assign an Hourly or Salaried CSA pay 
item on an employee-by-employee basis during the conversion. Salaried employees will be set as 
Hours-Insensitive. 

• A CSA pay item may be assigned to only one PAYMAN pay item. 
6. Deduction conversion: 

• The list of PAYMAN deductions shows the RPT HEAD and SCREEN text for standard deductions, in 
addition to the type (if any) assigned to the deduction within PAYMAN. The standard deduction number 
(1 through 12) is also shown. 

• If a standard deduction has been assigned to a specific type in PAYMAN (i.e., Fed W/H, SDI, Deferred 
Compensation, etc.), the conversion program will generally have pre-selected the proper CSA 
withholding or deduction item. You may select a different CSA item from the drop-down list in the PRS 
Deduction or Tax column. 

• The All Other Deds item is used to convert all other deductions that do not fit in any other category. By 
default, this deduction is set to convert to the CSA deduction item Other. 

• If you have set up any employees in PAYMAN with miscellaneous deduction items 1 and/or 2, they will 
appear in the list as Ded to Account XXXX (chart of accounts description). The conversion program 
will attempt to pre-select an appropriate CSA item based on the PAYMAN chart of accounts description. 
You may select a different CSA item from the drop-down list in the PRS Deduction or Tax column. 
Note: The conversion program uses the GL account to distinguish miscellaneous deductions from 
standard deductions. If a miscellaneous deduction uses the same GL account number as a standard 
deduction, it will be incorrectly combined with the standard deduction, and it will not appear in the list 
of deduction items The totals for the standard deduction may not be imported correctly in such cases. 

• With the exception of State & Local taxes, a CSA withholding or deduction item may be assigned to 
only one PAYMAN deduction item. State and Local taxes may be assigned more than once, but it is up 
to you to make sure that the duplicated items apply to different states or localities. 

7. Click F5=Next to continue to the next screen, which will present some final conversion options. The options 
are: 
• Current Payroll Month. This determines how QTD & YTD totals are distributed during the 

conversion when monthly detail is not available. By default, this will be set to the month of the current 
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Check Date or Period End Date. Since PAYMAN only retains QTD & YTD data for most items, and 
CSA maintains monthly totals, the QTD data will be posted to the current month and prior YTD data 
will be posted to the last month of the previous quarter (if applicable). The screen will show which 
months will be used during conversion. 

• Obtain hours data from Hours History file. This option will be active if the conversion program 
detects the presence of an Hours History file for the client. If this option is marked, hours data in the 
history will be summarized by month (where available) and the QTD/YTD hours totals are ignored. If 
the Hours History for the client does not contain valid data for the entire year to date, this option should 
be unmarked. 

• Obtain amounts from Annual Payroll Journal accounts. This option will be active if the conversion 
program detects the presence of an Annual Payroll Journal file for the client. If this option is marked, 
totals data in the journal will be summarized by month (where available), and the QTD/YTD totals are 
ignored. If the Annual Payroll Journal for the client does not contain valid data for the entire year to 
date, this option should be unmarked. Since detail in the journal is linked to pay and deductions via the 
GL account, this option should not be used in cases where the GL accounts are not unique for each type 
of pay/deduction item, or where any given pay or deduction for an employee uses more than one GL 
account in the current payroll year. 

• Convert Sub-Accounts to Departments. This option should only be marked if the CSA client has been 
converted from a Franklen CPA-11 or CPA-98 client where this option was also selected. The only 
effect of this option in PAYMAN conversion is to control how GL account numbers are converted. For 
additional information, see the Franklen CPA-11 or Franklen CPA-98 to CSA Conversion Guide. 

8. Click F5=Next to complete the conversion of payroll and employee data. After the conversion is complete, 
you are returned to the Client List screen. 

 

IMPORTING THE CONVERTED CLIENT DATA INTO CSA 
Use the following steps to convert and import a PAYMAN client into CSA. You may refer to this document for all 
information regarding this conversion. 

1. Open the CSA program. 
2. Create a new client in CSA by choosing New Client from the File menu. (For more information on creating 

a new client, choose CSA Help Topics from the Help menu and then; from the Index tab of the Help Topics 
dialog, search on New Client [File menu]. 

 
! Note: When adding the client to CSA, you must complete the current period end date, current fiscal year 

end, current payroll end date, and payroll frequency. The current period end date and current fiscal year 
end date should match what is entered in PAYMAN for this client. If you are converting general ledger 
and payroll information, you will also need to select both the General Ledger Solution and Payroll 
Compliance Solution modules when adding the client. 

! Remember that you may click the client information fields during the conversion and paste that 
information into the relevant CSA fields. 

 
3. Choose Utilities / Data Conversion / Franklen / Payman Import. 
4. In the first field of the Franklen Payman Import dialog, specify the location of the converted PAYMAN data 

files that you wish to import into CSA. This will generally be d:\FCS\EXPORT (where d: represents the 
drive letter where PAYMAN is installed. 
Example: If your PAYMAN data files are on drive F, you would enter F:\FCS\EXPORT.  

5. In the Client to import field, enter the PAYMAN Entity number for the client that you wish to import. It 
may be useful to print a list of clients from the PAYMAN program before beginning. The Print List of Clients 
report will show the entity number and the company name. 

6. If you wish to convert the employee earnings totals, mark the Convert Employee Earnings checkbox. 
7. Click the Import button. 

  (Continued) 
 
TL9924 Franklen PAYMAN to Creative Solutions Accounting Conversion Guide 
Page 4 Copyright © 1998 � 2002, Creative Solutions, a Thomson company. All rights reserved. 



Conversion Notes and Exceptions 
The following section details all known conversion exceptions between PAYMAN data and the converted CSA data. 
Conversion exceptions may include differences in field lengths between PAYMAN and CSA, required parsing of 
information from one field in PAYMAN to multiple fields in CSA, and manipulation of PAYMAN data to conform 
with CSA requirements, and so forth. 
 
After importing PAYMAN information into CSA, you will need to set up the local tax information that is used by your 
clients. 

Multiple Locality Codes 
PAYMAN supported eight Local withholding codes for a single client, which were not entered as a �global� setup 
code. 
 
The conversion adds the PAYMAN locality codes as needed to the list of available localities in CSA (in the Setup / 
System Configuration / Payroll Tax Information / Local dialog), and the conversion will add local withholding items 
for those localities to all applicable employees. However, the conversion is unable to set up the actual local tax tables 
and withholding information within CSA. This information will have to be set up manually after your have processed 
the conversion.  
 
To add the local tax setup information in CSA, please complete the following steps: 
1. From the CSA main window, choose Setup / System configuration / Payroll Tax Information / Local. 
2. Click the Add button and then enter the locality name in the description field and the effective date of the tax.  
3. Enter any allowances, fixed deduction, or credit amounts on the General tab. 
4. If your local tax is calculated using tables, click the �tables� button and enter applicable information. If your 

local tax is calculated based on a percentage of wages, enter than information on the Special Calculations tab. 

Support 
Web Site 
If you have questions or need assistance, you can visit our Web site at www.CreativeSolutions.com 24 hours a day 
for the latest information on current issues and processing tips. To take advantage of this convenient means of 
accessing information, choose On the Web from the CSA Help menu, and then click Product Support and Service.  
 
Product Support 
To speak with a Product Support Representative, please call the CSI HelpLine at 800-968-0600, press 3 for 
accounting support, and then listen to the options available before pressing the number for Payroll Solution. Normal 
weekday support is from 9:00 AM to 8:00 PM Eastern Time.  
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